


James Paterson, Editor  • james.paterson@futurenet.com

HIGHLIGHTS: WHAT’S INSIDE…

www.digitalcameraworld.com

15 ESSENTIAL 
RETOUCHING TRICKS  

Enhance your 
portraits with 
these top tips

SIMPLE FREQUENCY 
SEPARATION

Master this pro 
technique with 
our free Action

LIGHTROOM 
SKILLS

Learn all about 
the powerful lens 
correction controls

MASTER COLOR 
CORRECTION GELS

Shoot with CTO 
and CTB gels for 
amazing results

AMAZING NEW AI 
BACKDROP CREATOR

This Beta feature 
conjours images 
from text

We could all use a little polish from time to time, and 
this is what Photoshop is most famous for. This issue 
we explain a host of powerful yet simple retouching 
tricks that let you ‘Photoshop’ your subjects to 
perfection. Elsewhere, discover the new backdrop 
generator and learn about color correction gels. .

Also available on:

http://bit.ly/pp_pocketmags

http://bit.ly/pp_app_store

http://bit.ly/zinio_pp

DOWNLOAD THE 
PROJECT FILES

To download this 
issue's files, type the 

following link into 
your web browser on 

your 
PC or Mac:

https://bit.ly/PHO_145

http://bit.ly/practweet
http://bit.ly/pracface

FIND US HERE…

Editor 
James Paterson 

Art Editor  
Rosie Webber

Production Editor  
Richard Hill

Content Director 
Chris George

Group Art Director 
Warren Brown 

 Welcome to issue 145 of Practical Photoshop! 
If you enjoy the issue, why not subscribe and get 
a whole year for just $19.99?  

mailto:james.paterson@futurenet.com
http://www.digitalcameraworld.com
http://bit.ly/pp_pocketmags
http://bit.ly/pp_app_store
http://bit.ly/zinio_pp
https://bit.ly/PHO_145
http://bit.ly/practweet
http://bit.ly/pracface


 DOWNLOAD THE PROJECT FILES HERE  https://bit.ly/PHO_145 ON YOUR PC OR MAC 

Whether you want to completely transform a portrait  
or make a series of subtle enhancements, here are a host 

of retouching tips and techniques you need to know

https://bit.ly/PHO_145


The Adobe Portrait Profile is brilliant. It subtly shifts colors to prioritize natural skin 
tones, and creates a better starting point for your portrait editing. So before you do 

anything else in Camera Raw or Lightroom, change the Profile of the image to Adobe Portrait 
in the Profile Browser at the top of the Basic Panel (it’s only available with raw images).

START WITH ADOBE PORTRAIT



The Skin Smoothing Neural Filter employs AI to smooth skin automatically. It can detect 
faces and apply a subtle smoothing effect to the skin. While Skin Smoothing is not 

perfect, it is capable of producing natural-looking results if you can take control…

B E F O R E

A F T E R

U S E  A U T O  S K I N  S M O O T H I N G



01 OPEN THE SKIN SMOOTHING FILTER
Open your portrait image in Photoshop, then go to Filters > Neural Filters. Toggle on 

the Skin Smoothing Filter. You can experiment with the Blur and Smoothness Filters too, 
although these typically tend to have minimal impact on the overall effect. Once done, 
set Output to New Layer and click OK. 

02 REVEAL WITH 
A MASK

Toggle the layer visibility 
off and on, and you’ll see 
that the Skin Smoothing 
effect usually smudges out 
details in the face. So hold 
Alt and click the Add Layer 
Mask icon in the Layers 
Panel. This adds a full black 
Layer Mask. Grab the Brush 
Tool and paint with white to 
reveal the smoothing effect 
over the skin.



Frequency Separation is considered by many to be the most controlled method for 
skin retouching, and it’s one favored by pro retouchers. We’ve included a set of Actions 

with this issue’s project files that speed up the process for you. Here’s how to use them, then 
carry out the frequency separation technique…

B E F O R E

A F T E R

U S E  O U R  F R E Q U E N C Y 
S E P A R A T I O N  A C T I O N S

WATCH THE VIDEO
https://bit.ly/403x4Kk

https://bit.ly/403x4Kk


01 LOAD THE ACTIONS
Drag the supplied retouching .atn file 

into Photoshop to load in the retouching 
Actions. You’ll find a Frequency Separation 
Action within the set. Play the Action. 
When it comes to choosing a blur amount, 
set a value that only just blurs the fine 
details of the image.

03 SPOT-HEAL THE TEXTURE
The Texture layer contains all the 

fine high-frequency detail (like hair, skin 
pores, fine lines and other textures). Grab 
the Spot Healing Brush, and uncheck Sample 
All Layers in the tool options. Paint around 
the portrait to remove any small spots and 
other tiny distractions. 

02 CLONE TO SMOOTH THE SKIN
The Frequency Separation Action 

creates two layers: one called Texture, the 
other Colour. Highlight the Colour layer and 
grab the Clone Tool. Set Sample to Current 
Layer, then use the Clone Tool to smooth 
over any rough patches on the skin, or any 
areas of uneven tonality.

04 TWEAK THE COLORS
To complete the portrait, we used 

a Color Lookup layer. Click the Create 
Adjustment Layer icon in the Layers Panel 
and choose Color Lookup. We used the 2 
Strip effect under the 3DLUT menu (if this 
isn’t available, make sure your image’s Color 
Mode is RGB  via Image > Mode > RGB Color).



Blemish removal is easily done using 
the Spot Healing Brush, which simply 

allows you to paint over small spots and 
imperfections to remove them. It works best 
for removing small marks from otherwise 
clean areas, which makes it ideal for 
retouching spots and pimples from skin. 

Grab the tool from the Tools Panel, then 
check the Sample All Layers in the tool 
options at the top. Make a new layer (so that 
you don’t make permanent changes to your 
original image), then zoom in close and paint 
to remove small imperfections. Use the [ and 
] keys to resize the brush tip as you paint.

SPEEDY BLEMISH REMOVAL



When you retouch a portrait, you’ll 
often need to zoom in and out 

to different areas at speed. The easiest way 
to do this is to hold Cmd/Ctrl+Space, then 
click in the image and drag to the right to 

zoom in, or left to zoom out. You’ll zoom in 
to the point you click on when dragging. 
Double-click the Zoom Tool to jump to 100% 
view. Double-click the Hand Tool to fit the 
entire image on-screen.

ESSENTIAL ZOOMING SHORTCUTS



C L O N E  I N  L I G H T E N  M O D E
To quickly smooth out an area of 
uneven tonality in skin, perhaps to 

tone down bags under eyes or soften 
wrinkles, first press Cmd/Ctrl+J to make a 
copy of your layer. Grab the Clone Tool, then 

go to the tool Blending Mode options (not the 
layer options) and set it to Lighten. Press 2 
for 20% brush opacity, then Alt-click to 
sample a clean area of skin nearby. Paint to 
clone over the rough area until it’s smooth.

B E F O R E A F T E R



M A S T E R  A I  P E O P L E  M A S K S

So much of portrait retouching is 
about isolating parts of the face in 

order to make targeted edits. The Mask 
command in Camera Raw and Lightroom 
helps you out enormously in this regard. 
It lets you automatically create masks for 
areas of the face like eyes, lips, eyebrows, 
skin and more…

B E F O R E

A F T E R

WATCH THE VIDEO
https://bit.ly/42hvfee

https://bit.ly/42hvfee


01 USE PEOPLE MASKING 
Open the image into 

Camera Raw, click the circular 
Mask icon on the right to open 
the Mask Panel, and go to the 
People section. Hover over 
each facial feature to see an 
automatic mask generated 
by the software. Check one or 
several, then click Create to 
make a mask.

02 ADJUST THE AREA
Once the mask is made, 

you can use the sliders on 
the right to alter the area 
in any way you choose. An 
iris, for example, can benefit 
from lightening and a boost 
in saturation. Here we’ve 
softened the hair by setting 
negative Clarity.

03   COMBINE MASKING 
TOOLS 

We can also use these People 
Masks in combination with 
other masking tools. Here the 
hair is darker on top of the 
head. We can first make an 
automatic mask for the hair, 
then click the Subtract button 
and use a Linear Gradient to 
subtract the bottom part of 
the mask. Then we simply lift 
the shadows.



If you’re working on a portrait in 
Camera Raw or Lightroom, setting 

negative Texture can be very useful for a 
quick skin smoothing effect. Texture is ideal 
because it leaves very fine detail alone while 
smoothing out the slightly less fine detail. 
As such, it allows you to add a skin smoothing 

effect without damaging the textures and 
pores that are vital to a natural-looking 
result. Try using the Brush Tool to paint 
over skin, then drop the Texture value. 
Try combining negative Texture with 
the AI portrait masking technique from 
the previous tip to isolate the face skin.

SET NEGATIVE TEX TURE FOR SKIN



A subtle boost to the eyes can make a big difference – but which areas do we change, 
and which settings are best? To find out, open the image into Camera Raw. Press K 

and paint to make a mask over a part of the eye (or isolate it automatically with the people 
masking tools in Camera Raw and Lightroom), then go to the sliders on the right and use the 
following settings as a guide…

HOW TO BOOST EYES

1

IRIS
SETTINGS: EXPOSURE +0.35,  

SATURATION +25, CLARITY +40 
Isolate the irises with 
a mask, then increase 
Exposure, Clarity and 

Saturation to boost the area.

2

EDGE OF IRIS
SETTING:  

EXPOSURE -0.50 
Use a small brush and paint 
a thin line around the edges 

of the iris. Decrease Exposure 
to darken the area slightly.

3

SCLERA
SETTINGS: EXPOSURE +0.65,  

TEXTURE -100, SATURATION -20 
Isolate the whites of the 

eyes, then increase Exposure. 
Keep it subtle. Reduce 

Texture to soften veins.

1
3

2



HOW TO BOOST EYES

4

LASHES
SETTING:  

SHARPENING +30 
Press K and paint a mask 
for the lashes, then try 
increasing Sharpening 

to crisp up the area.

5

EYEBROWS
SETTINGS: EXPOSURE -0.25,  

CLARITY -15 
Isolate the eyebrows, then 

try decreasing Exposure 
and Clarity slightly to 

soften the area.

6

CATCHLIGHT
SETTING:  

HIGHLIGHTS +50 
Boost the catchlight in the 

eye by painting over the area 
then increasing Highlights 

to bring it out more.

5

6

4



Presets can speed up your workflow 
by letting you apply a series of 

settings with a single click. They’ve always 
been useful for toning effects, but recently 
they’ve been improved with the addition of 
Adaptive Presets. These work in combination 
with the AI Masking tools, so you can make 
presets that combine with automatically 
generated masks to, for example, darken a 

sky or lighten a background. Head to the 
Preset Panel in Camera Raw or Lightroom, 
and you’ll find a set of People Presets that do 
things like enhance eyes and whiten teeth.

You can also create your own Adaptive 
Presets with ease. Simply make an AI mask 
for a part of the face, alter the area, and click 
the New Preset icon in the Preset Panel to 
save it for use on other images.

USE ADAP TIVE PRESETS



W O R K  T H E  B A C K G R O U N D
The background in your portraits can 
often benefit from tweaks so it works 

in harmony with the subject. The masking 
tools in Camera Raw and Lightroom allow you 
to quickly make a mask for the background, 

so you can lighten, darken, change colors 
and more in just a few seconds. Here we’ve 
darkened one side of the backdrop, first by 
making a mask for the background, then 
subtracting a linear gradient.

B E F O R E A F T E R

WATCH THE VIDEO
https://bit.ly/3FFpEET

https://bit.ly/3FFpEET


C O P Y  A R E A S  T O  R E M O V E  H A I R
Single stray hairs can usually be removed with a quick swipe of the Spot Healing Brush, 
but a thicker tangle of strands (as seen in our Before show below) can make things 

more difficult. When an area is obscured, you might even have to copy and flip areas from the 
other half of the face to remove the hairs…

B E F O R E

A F T E R



01 USE THE LASSO 
Grab the Lasso Tool 

and make a rough selection 
over the clear part of the 
face that you want to flip, 
then press Cmd/Ctrl+J to 
copy the selected area to a 
new layer. Press Cmd/Ctrl+T 
to transform the layer, then 
right-click it and choose Flip 
Horizontal from the pop-up 
menu that appears. 

02 FLIP AND POSITION
Use the bounding box 

to reposition and rotate the 
layer into place. You might 
want to reduce the layer 
opacity, and use the arrow 
keys to nudge the position 
pixel by pixel until it lines 
up neatly. Once done, press 
Return to apply, then restore 
the layer opacity to 100%.

03   PAINT TO REVEAL 
Hold Alt and click the 

Add Layer Mask icon to add a 
full mask that hides the layer. 
Grab the Brush Tool and set 
the foreground color to white, 
then paint to gradually reveal 
the layer and cover up the 
offending strands of hair.



D O D G E  A N D  B U R N  T O  S C U L P T  F A C E S
Selective lightening and darkening 
can enhance a face by sculpting the  

features. In general, it’s best to use the Burn 
Tool set to either Shadows or Midtones and 
the Dodge Tool set to Highlights, using a low 

Exposure value. Darken down the underside 
of the cheekbones, underneath the chin and 
under the nose; then lighten the tops of the 
cheeks, the ridge of the nose, the forehead 
and the lips.

B E F O R E A F T E R



Catchlights are the little reflected 
highlights we see in a person’s eyes, 

and they’re great for focusing attention on 
the ‘window to the soul’. Sometimes 
catchlights can look a little dull, so try 
dodging them with the Dodge Tool. For 
greater impact, try cloning a weak catchlight 

from one side of the iris to the other. Make 
a new layer and grab the Clone Tool. Click 
the Clone Source Panel icon in the tool 
options at the top. Check Flip Horizontal  
and/or Flip Vertical in the Clone Panel then 
Alt-click to sample the catchlight and paint 
to clone it over the other side of the iris.

COPY A CATCHLIGHT



If you want to tidy the hairs around 
the edges of a face, then it can be a 

nightmare to do so with the healing tools. 
Instead, go to Filter > Liquify. Grab the 
Freeze Mask Tool from the toolbar and paint 

over the main bulk of the hair to lock it into 
place. Switch to the Forward Warp Tool, and 
use it to push the stray hairs in towards the 
face. Click OK and finish off by cloning any 
messy details along the edge.

LIQUIF Y STRAY HAIRS



If you’ve been 
paying attention to 

photography news, you 
can’t have failed to notice 
the furore over AI image 
generation. Generators 
like Stable Diffusion, Dall-E 
and Midjourney make it 
possible to create artwork 
from nothing more than 
a descriptive sentence. 
This has caused a great 
deal of excitement and 
apprehension among 

photographers, and 
the way these tools 
gather and reassemble 
the substance of 
existing photos raises 
real concerns about 
intellectual property. 
One thing is certain: 
we’re entering a new 
era of image-making.

Users looking to 
experiment with text-to-
image generation will find 
an intriguing new tool 

within Photoshop Beta. 
The Backdrop Creator 
Neural Filter lets you 
create a new backdrop 
from a few words. Of 
course, Beta means it’s not 
the finished article, but 
it’s worth experimenting 
with. Backdrop Creator 
is designed to work with 
your photos, and may 
offer a glimpse of how 
photography and AI 
can work together.

GENERATE AI BACKDROPS IN PHOTOSHOP
Meet the new filter that creates brilliant  

backgrounds based on a few words

 DOWNLOAD THE PROJECT FILES HERE https://bit.ly/PHO_145 ON YOUR PC OR MAC 

BEFORE

AFTER

WATCH THE VIDEO
https://bit.ly/3n6Awp1

https://bit.ly/PHO_145
https://bit.ly/3n6Awp1


1

PHOTOSHOP BETA
Photoshop Beta is a separate 
application to Photoshop. In 
most regards it’s identical, 

but Adobe uses it to trial 
new tools and filters like the 
Backdrop Creator filter, while 

gathering usage data that 
helps to shape the finished 

product. Anybody with a 
Creative Cloud subscription 
can download it. Open your 

Creative Cloud app and go to 
the Beta Apps tab, install it, 
then launch it and open an 

image to get started.

2

BACKGROUND 
CREATOR FILTER

Background Creator can 
be found under Filter > 

Neural Filters. You’ll need 
to download the filter if it’s 

your first time using it. It 
won’t let you craft highly 

detailed scenes, so you won’t 
get photo-realistic results. 
It’s more geared towards 

creating abstracts, patterns 
and blurred impressions. It 

works well in portraits where 
the background would be 
out of focus, for example.

1

3

2

3

TEXT PROMPTS
Type your text prompts here. 

We tried ‘neon street sign, 
pink, blue’ to generate the 
backdrop for our portrait. 
Some text prompts aren’t 
permitted – for instance, 

anything related to people 
will be met with ‘Filter does 

not support human imagery’. 
You’ll also occasionally see 

that words are omitted. You 
might find you get slightly 

more detailed images if you 
add in words like ‘HD’ (high 
definition) or ‘photograph’.



4

GENERATED IMAGES
After typing your text 
prompt, the filter will 

generate three images. 
Click on the thumbnail to 

see how one will look. Any 
ticked images will be created 
as separate layers once you 
click OK. If you like the look 
of any image but want to 
see more variations of it, 

click the ‘More like this’ icon 
to generate three more 

options. Set Variety to a high 
value, or use a low value to 

focus on specifics.

5

CUT OUT
Begin your composite by 

cutting out a person or object 
for the foreground. Open 

the image, then go to Select 
> Select And Mask. Click the 
Select Subject button, then 
click the Refine Hair button. 
Use the sliders to fine-tune 
the selection edge, then set 

Output to New Layer With 
Layer Mask and click OK. 

Next, highlight the bottom 
layer, then go to Filter > 

Neural Filters to start using 
Background Creator.

6

TRY HARMONIZE
Once you’ve generated 

the new backdrop, it’s likely 
that you’ll need to tweak 
the colors in the subject. 
The Harmonize Filter can 

be useful. Go to Filter > 
Neural Filters and turn 

on Harmonize. Target the 
background in the Source 
dropdown, then use the 
sliders to fine-tune the 

results. Output to a new layer 
and experiment with the 

layer opacity to control the 
strength of the effect.

6

4

5



Off-camera flash 
can be wonderful 

for portraiture. It picks 
out your subject and gives 
your shots a unique style. 
But many of us who use it 
pay little attention to the 
color temperature of the 
light our flash is blasting 
out. By controlling the 
color and our camera’s 
white balance settings, 
we can create all kinds 
of interesting effects.

Measured in degrees 
Kelvin, color temperature 
is a scale for the hue of 
light, from warm orange 

shades to cool blue shades. 
Natural light shifts along 
the scale at different 
times of day, from morning 
warmth to midday cool 
to sunset warmth again. 
We can alter our camera’s 
white balance so white 
objects appear white in 
our photos, no matter the 
color of the light. If we add 
light of our own, we can 
tint our light sources with 
gels to work in combination 
or as a contrast to the 
ambient light.

But we can also create 
a warmer scene and 

enhance those sunset 
vibes not by warming 
our flash, but by cooling 
it down. This may sound 
counter-intuitive – surely 
a warming gel warms the 
scene? In fact, it would tint 
our subject’s skin orange, 
so if we wanted to keep 
the skin tones natural, 
we’d have to cool the 
image in post to correct it. 
So if we direct cool flash 
light at our subject, we 
have to warm the white 
balance to correct the skin, 
which in turn warms up 
the rest of the scene.

Discover the creative potential of using  
color correction gels with James Paterson

IT’S COOL TO BE WARM

 DOWNLOAD THE PROJECT FILES HERE http://bit.ly/PHO_145 ON YOUR PC OR MAC 

WATCH THE VIDEO
https://bit.ly/3LBxfbj

http://bit.ly/PHO_145
https://bit.ly/3LBxfbj
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5

4
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COLOR CORRECTION GELS ON LOCATION
Get set up for off-camera flash and learn to shift 

your colors for wonderfully warm backdrops

1 OFF-CAMERA FLASH
Our off-camera flash here is 
set to manual mode at 1/8 

power and attached to a light 
stand via an umbrella fitting. 
The flash is positioned to the 
side of the subject to deliver 

soft, directional light over 
the face, and also serves 
to emphasize the texture 

of the frosty fallen tree 
below our model.

4 USE AN UMBRELLA 
A light modifier diffuses 

and spreads the light from 
your flash, which usually 

makes it more flattering for 
portraiture. We used a large 

parabolic silver umbrella here. 
Parabolic umbrellas have 

more panels than standard 
ones, and tend to have more 

of a wraparound quality.

2 COOLING THE LIGHT
Our flash is fitted with a 

1/2 Color Temperature Blue 
(CTB) gel. This cools down 

the light source, producing 
blue light over our subject. 

By setting our white balance 
to match the cool light hitting 

the subject, we can make 
the light in the background 
appear warmer while still 

retaining natural skin tones.

5 SHOOT INTO THE SUN
There are three benefits to 

shooting into the setting sun. 
First, it backlights the subject 

and creates an attractive 
halo. Second, it places their 

face in shade so the ambient 
light has less of an influence 

on skin tones. Third, the 
colors around the setting sun 

are usually really vibrant.

3 EXPOSURE AND 
WHITE BALANCE

The camera is in Manual 
mode with a shutter speed 

of 1/200 sec, ISO100 and 
an aperture of f/3.5. After 
taking a test shot with just 

the ambient light, our white 
balance was initially at 

around 6,200K. After turning 
on the flash, we shifted it to 
9,000K to warm the scene.

6 SHOOT IN RAW
If we set our camera to raw 

format, it records more color 
information, which can be 

hugely useful while shooting 
mixed color temperatures. 
It gives us a safety net to 

alter the white balance after 
the fact, with exactly the 

same results as if we’d set it 
before taking the shot.



GO WARM OR COOL WITH COLOR GELS

01 ORANGE AND BLUE
These color correction 

gels are Color Temperature 
Orange (CTO) and Color 
Temperature Blue (CTB). They 
come in different strengths, 
and you can double up the 
gels to make them stronger. 
A full CTO will shift your light 
temperature from daylight 
to 3,200K, and a full CTB will 
shift 3,200K to daylight.

02 DAYLIGHT-BALANCED 
Here are the effects of 

the flash without any color 
gels. Flashlights are daylight-
balanced, so they’re roughly 
the same light color as the 
daylight, at around 6,000-
6,500 Kelvin. By setting our 
white balance to this amount, 
the subject’s skin tones look 
natural, but the backdrop 
looks dull.

03  FIT A CTB GEL 
We used a pack of 

Selens gels, designed to fit 
neatly over a flashlight with 
a rubber band. First we used 
a 1/2 Color Temperature 
Blue gel. This has the effect 
of cooling the light source. 
To compensate, we can shift 
our white balance to around 
9,000K, which cancels out 
the blue light.



 COMBINE IMAGES TO FORM THE BEST BLUR

04 WARM UP THE 
AMBIENT LIGHT

Once our white balance is 
locked in, any other light 
sources in the scene that are 
higher in Kelvin will appear 
cooler, while any light sources 
that are lower in Kelvin will 
appear warmer. As such, the 
shift in white balance has 
a profound effect on the 
warmth of the backdrop.

05  FIT A CTO GEL 
As well as warming the 

backdrop, we can also go the 
opposite way and cool it down 
by using a CTO gel instead. 
We used a full CTO here. Keep 
in mind that whenever you 
fit a color gel, you’re going 
to be reducing the strength 
of the light, so you’ll need to 
increase the flash power by 
a stop or so.

06  COOL THE 
BACKGROUND 

The CTO gel warms the skin 
tones, so after compensating 
for this by reducing the white 
balance to 4,000K, the rest of 
the scene becomes very blue. 
Note, too, how the shadow 
side of the face here is tinted 
warmer than the highlight 
side. This is the ambient 
light mixing with the flash.



TOP TIPS CHOOSE YOUR KELVIN

01 SET THE KELVIN 
VALUE IN-CAMERA 

When you mix your color 
temperatures, it’s best to set 
the white balance in-camera 
while shooting, rather than 
leaving it to Auto White 
Balance. The built-in white 
balance presets like Shade 
and Sunny can be a bit basic, 
so instead set it to K, and try 
shifting the Kelvin setting 
one way or another.

02 CHANGE THE WHITE 
BALANCE IN POST

If you shoot in your camera’s 
raw mode, then you’re free 
to alter the white balance 
or choose a preset later on. 
In either Camera Raw or 
Lightroom, you can use the 
White Balance Eyedropper 
Tool to click on a neutral point 
in the scene, like a white 
T-shirt or a grey rock, to set 
the white balance for you.

03   CHECKING FOR 
COLOR CASTS 

Sometimes it can be tricky to 
find the right temperature 
and tint settings for your 
photo, but here’s a trick that 
can help. Temporarily increase 
the Saturation and Vibrance 
sliders all the way to +100. 
This will make color casts far 
more obvious. After fine-
tuning the white balance, 
reset the sliders.



MIX COLOR TEMPERATURES IN PHOTOSHOP

The improved AI 
masking tools in 

Lightroom and Camera Raw 
allow you to quickly isolate 
either a subject or a 
background. There are 
buttons for each, so all you 
have to do is click one, and a 
mask will automatically be 
generated for either area.

Once done, you can 
go on to alter either area 
using an array of powerful 
tonal tools. These include 
Temperature and Tint sliders 

that let you selectively 
change the white balance in 
different parts of the frame. 
So you can experiment by 
selectively shifting the 
white balance controls for 
either the subject or the 
backdrop. This could serve to 
correct a mismatch between 
the two – or instead create 
one, as we’ve done here by 
cooling the backdrop, which 
helps the subject stand out 
and improves the rather dull 
original background. 

Use Photoshop’s new intelligent AI masks  
to selectively shift the white balance in seconds



If you’d like to watch the  
complete course now, get the 
app from the Apple App Store

This issue, learn all about 
how to apply powerful lens 
corrections to your photos

LIKE THIS? NOW AVAILABLE ON 
THE APPLE APP STORE BIT.LY/TYLRAPP

WATCH THE VIDEO
https://bit.ly/3TrNJog

http://BIT.LY/TYLRAPP
https://bit.ly/3TrNJog


GURUSHOTS
Practical Photoshop has joined up with GuruShots, ‘the world’s greatest 

photography game’, to showcase the winning images from a series of 
photo challenges. These are the winning and commended images from 

the ‘Street Photography’ challenge

EVA WIEDEMANN, AUSTRIA 
TOP PHOTOGRAPHER WINNER

 ADVERTISING FEATURE



STANISLAV SITNIKOV, RUSSIA
TOP PHOTO WINNER

 ADVERTISING FEATURE



GABRIEL BERTINO, ARGENTINA 
GURU’S TOP PICK

 ADVERTISING FEATURE



HONOURABLE MENTIONS
 ADVERTISING FEATURE

SARI ELENA RAATEROVA, FINLAND

PEDRO GARCIA, UNITED STATESSANJA, BOSNIA AND HERZEGOVINA



ARKADIUSZ STAŃ, POLAND

ROBERTO VALDES, CUBA

HONOURABLE MENTIONS
 ADVERTISING FEATURE



PAUL FOX, UNITED KINGDOM YANA RAAGA, LATVIA

HONOURABLE MENTIONS
 ADVERTISING FEATURE

HARJEET KAUR, SPAIN



TRAVELER DON, UNITED STATES

JOE HAMILTON, UNITED STATES

HONOURABLE MENTIONS
 ADVERTISING FEATURE

MICHAEL GORDON, ISRAEL



JUAN MANUEL GARCIA REY, SPAIN

BRYONY HERROD-TAYLOR, UNITED KINGDOMCLARENCE LIN, UNITED STATES

HONOURABLE MENTIONS
 ADVERTISING FEATURE



HONOURABLE MENTIONS
 ADVERTISING FEATURE

VALDIS KU, LATVIA

WILLIAM CURNUTT, STATESMARIUS FORGACIU, ROMANIA



GLEN JONES, AUSTRALIA REKA PATOCS, HUNGARY

YARON TAL, ISRAEL

HONOURABLE MENTIONS
 ADVERTISING FEATURE



Your quick-start guide and reference  
to image editing in Photoshop

If you’re relatively new to editing in 
Photoshop, or you just don’t know 

where to begin, then this section is the best 
place to get started. Over the next 10 pages, 
you’ll find an overview of the different versions 
of Photoshop available; a breakdown of the 

typical image-editing workflow in Photoshop; 
an overview of raw file editing; a guide to the 
six most useful layers; and a glossary of the 
most useful shortcuts. This guide condenses 
most of the tools and techniques you’ll use 
every time you import a new roll of pictures.



CREATIVE CLOUD PLANS 
CHOOSE THE PLAN WITH THE COMBINATION OF TOOLS AND STORAGE YOU NEED

Photography Plan • 20GB Photography Plan • 1TB

Best for Traditional desktop users Cloud and desktop

Price per month £9.98/$9.99 £19.97/$19.99

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 20GB 1TB

Notes

If you want Photoshop, 
you need the regular 

Photography Plan – you 
also get Lightroom Classic

The same as the Photography 
Plan, but with 1TB storage. 
Existing users are offered 

a discount for the first year

Lightroom Plan All Apps Plan

Best for Cloud fans Mobile-only users

Price per month £9.98/$9.99 £51.98/$54.99

Photoshop CC

Lightroom CC

Lightroom Classic

Lightroom Mobile

Cloud storage 1TB 100GB

Notes
With this plan you get the ‘new’ 
Lightroom CC and 1TB storage – 

but not Photoshop

Includes all Adobe apps, 
including Illustrator, Premiere 

and After Effects



Lightroom CC combines 
professional image-
processing tools with 

asset organizing. It keeps all its 
images online in the Creative 
Cloud, with advanced image 
search capabilities.

Lightroom Classic 
offers editing and 
organizing tools, but 

you can only store images on 
your computer.

LIGHTROOM CC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

LIGHTROOM CLASSIC
FROM £9.98/$9.99 PER MONTH  
WINDOWS, macOS

Lightroom Mobile is 
the lightweight iPad, 
iPhone and Android 

version of the application, 
integrated with Lightroom 
CC. You can use Lightroom 
Mobile on its own for free, 
or use the Premium In-App 
Purchase to access the Adobe 
Creative Cloud. This enables 
you to create a collection 
of photos on your desktop 
copy of Lightroom, and sync 
them via the Creative Cloud 
to Lightroom Mobile on your 
portable devices. You can also 
get Lightroom Mobile via any 
Photography Plan.

LIGHTROOM MOBILE
FREE (PREMIUM: £4.49/$6.49 PER MONTH)
IPHONE, IPAD, ANDROID 

Photoshop is the software of choice for most professional 
and non-professional photographers. Beyond the standard 
photo-editing features, it boasts a vast array of more 

creative tools and filters. Layers are one of the key differences 
between Photoshop and Lightroom. They enable you to mask 
out selected parts to build up increasingly sophisticated images.

PHOTOSHOP CC 
FROM £9.98/$9.99 PER MONTH WINDOWS, macOS 

Elements is the consumer variant of Photoshop, and 
contains many of its key tools and features within a 
simplified interface. It’s limited, but it does provide access 

to layers for those who have switched to a Lightroom workflow.

ELEMENTS 15 £79.99/$99.99  WINDOWS, macOS



Adobe Shape enables 
you to turn photos and 
sketches into beautiful 

vector shapes for use in your 
designs or artwork. The app 
smooths out jagged edges in 
images, resulting in gorgeous 
vectors that are endlessly 
scalable, just as if you’d drawn 
them by hand with the Pen tool. 
Make a shape with the mobile 
app and the next time you open 
Photoshop on your desktop, the 
shape will sync to your Library. 
Drag it in to any document to 
add color and make further 
adjustments.

ADOBE SHAPE
FREE
IPHONE, IPAD, ANDROID 

Adobe Brush enables 
you to make your 
own custom brushes 

from photos or sketches for 
use in Photoshop, Illustrator 
or the Sketch app. The most 
successful subjects are usually 
those that can be easily 
isolated, such as a splash 
against white, or a leaf against 
the sky. You can capture objects 
for your brush tips using your 
device’s camera, choose from 
your camera roll, or use your 
Creative Cloud library. Once 
captured, you can then fine-
tune the look of the tip and 
apply brush settings.

ADOBE BRUSH
FREE
 IPHONE, IPAD, ANDROID 

Mix enables you to merge two photos together 
to create a composite image. It offers a simplified 
compositing process that makes it easy for beginners 

to start combining an object from one image with a background 
from another. You can then send the composite to Photoshop 
for further edits. If you like, you can also use Mix to edit a single 
image. It offers a few simple tonal adjustments and more 
complex edits such as Content-Aware Fill.

If you ever need help 
selecting coordinated colors 
for your designs, try using 

Adobe Color. It enables you to create 
color themes from photos taken on 
your mobile device. This could be 
anything from a scene in your local 
park to a famous painting. So if you 
come across an inspirational scene, 
capture the colors and save them.

ADOBE PHOTOSHOP MIX
FREE IPAD, ANDROID

ADOBE COLOR
FREE IPHONE, IPAD, ANDROID 



As the name suggests, this app enables you to paint 
freehand using a selection of brushes, colors and other 
tools. However, Sketch is more than just a painting 

app. It also enables you to connect with like-minded creatives, 
so you can follow artists and see their work updating. Once 
you’re done sketching the image on your iPad, you can upload 
to the Sketch community, or continue working on the image 
in Photoshop CC. You can also bring in brushes made with 
Adobe Brush, and for those who can’t paint, there’s an option 
to overlay images so you can trace over a photo. Sketch is 
compatible with Adobe’s pen and ruler hardware, Ink and 
Slide, but you can get great results with your finger.

Fix is a retouching app 
for altering portraits and 
fixing marks or blemishes 

in your photos. Intelligent facial 
recognition locks onto eyes, lips 
noses and chins, making it easy to 
tweak a smile, tuck in a jawline or 
enlarge eyes, should you wish.

ADOBE PHOTOSHOP SKETCH
FREE IPAD

PHOTOSHOP FIX
FREE  IPAD 

If you’re a designer 
who wants to build 
a quick layout for a 

web or print page, then Comp is 
the ideal place to start piecing 
ideas, images and text together. 
You can draw common design 
elements such as text or image 
boxes with quick gestures. For 
example, a couple of squiggly 
lines with a dot makes a 
header, and a cross makes an 
image box. It makes it easy to 
mock up a layout in seconds. 
You can then add words and 
graphics. The app even spits 
out a Photoshop, Illustrator or 
InDesign document.

ADOBE COMP CC
FREE IPAD

Behance is the online 
social space for 
creatives to share 

and showcase their portfolios, 
connect with one another, 
and find work. With work 
from the best photographers, 
digital artists and designers 
out there, it’s also a great 
place to find inspiration for 
a new project. If you’re a 
Creative Cloud subscriber you 
can set up a Behance page in 
minutes. The Behance app 
for iOS devices enables you to 
manage your page, while the 
Creative Portfolio app provides 
a polished portfolio.

BEHANCE 
CREATIVE PORTFOLIO
FREE IPAD, IPHONE
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The image-editing process begins as 
soon as you’ve transferred your photos 

from your memory card to your computer.
The first stage is to begin sifting 

through your pictures to discover which are 
the keepers. The image organizer that comes 
with Photoshop is ideal for this task. Adobe 
Bridge has controls for keywording, rating and 
filtering your images, and there are handy tools 
for batch renaming files, creating panoramic 
stitches, making contact sheets and more.
        Launch Adobe Bridge and navigate to a 
folder containing new images. Use the cursor 
keys to quickly flick through the images and 
click below a thumbnail to add a star rating, or 
use the keyboard shortcut Cmd/Ctrl+1-5. You 
can then filter your photos by the star rating to 
group the ones you want to work on.

   The next step is to open the shots from 
Bridge into Adobe Camera Raw. ACR is the best 
place to make initial changes to your images 
to boost tones and correct any problems with 
exposure and so on. It doesn’t enable you 
to combine images – you’ll use Photoshop 
for that – but it does enable you to make 
the kind of edits photographers need.
      In Photoshop, you can further refine the 
image with layers and adjustment layers, which 
offer a much more flexible way of working than 
ACR. Once you’ve finished, it’s time to share 
it with an audience. Go to File>Save, and your 
image will be saved as a Photoshop document 
(PSD). This keeps all the layers intact, which 
means you can go back and retweak the image 
at a later date. However, PSD files are large 
and can take up lots of hard drive space. If you 
want to share your images online or via email or 
social media, save them as JPEGs.

Manage your photos from capture to output in three stages

2

1

3



Discover how to process your raw files to perfection

The latest version of the raw file 
processor included with Photoshop is so 

powerful that most photos can be processed 
entirely in the raw processor, with no need for 
further editing in Photoshop. And by making 
your adjustments in Adobe Camera Raw, 

rather than in Photoshop, you’ll ensure the 
best possible image quality, because raw files 
contain more picture information than bitmap 
images such as un-layered PSDs and JPEGs. 
Here’s our reference to the features you’ll 
use the most in the Basic panel.

THE BASIC 
PANEL IN ACR

TEMPERATURE
Use this slider to warm 
or cool an image if the 
White Balance tool fails 
to correct a color cast

CONTRAST 
Makes light pixels brighter 
and dark pixels darker

CLARITY
Controls the amount 
of midtone contrast

SATURATION
Controls the overall color 
intensity of the image

TINT 
This slider enables you to 
correct a green or magenta 
cast, again, if the White 
Balance tool fails

HIGHLIGHTS 
Controls the brightness 
of the lightest pixels

EXPOSURE 
Controls the overall 
brightness of the image

BLACKS 
Sets a point on the tonal 
range at which pixels 
should be pure black

SHADOWS
Controls the brightness 
of the darkest pixels

WHITES 
Sets a point on the tonal 
range at which pixels 
should be pure white

VIBRANCE
Adjusts the intensity of 
the less-saturated colors



The six most frequently used Photoshop layers for image 
editing, and how to use them to improve almost any photo

Photoshop has many types of layers 
and adjustment layers available, but 

there are six that you’ll find you need to use 
again and again. Learning how they should be 

used may seem a little daunting for beginners, 
but once you’ve got to grips with them, you’ll 
find they play a part in the creative process of 
almost every image you make.

02 CURVES
Curves is one of the most powerful 

adjustment layers. An S-shaped curve 
brightens the highlights and darkens the 
shadows, resulting in extra contrast. Create 
a Curves Adjustment Layer and click the 
middle of the diagonal line to add a central 
control point. Drag down on the lower part 
of the line and drag up on the upper part of 
the line to improve image contrast.

01 LEVELS
This should be the first layer you add 

to an image, because it fundamentally alters 
the tonal range of the entire image. Create 
a Levels Adjustment Layer, drag the Black 
point slider inwards until it touches the left-
hand edge of the histogram, and drag the 
White point slider inwards to the right-hand 
edge. This remaps the tones of the image to 
make more of the available tonal range.

03 HUE/SATURATION
This adjustment layer is best used 

for altering the intensity and brightness 
of individual color channels in an image – 
greens and blues in landscapes, for instance. 
Create a Hue/Saturation Adjustment Layer, 
click the Master menu and choose the color 
channel you’d like to adjust. Small changes 
are usually the most effective.



BEFOREAFTER

06 SELECTIVE SHARPENING
Once all other adjustments have 

been made, you need to sharpen the image 
for output. The traditional way is to create a 
merged layer at the top of the stack, apply 
Unsharp Mask, then paint on the mask to 
remove the sharpening from those parts 
of the image you want to remain soft. 
However, the Sharpen tool enables more 
control over the process by enabling you to 
build up the effect by brushing repeatedly 
with a low opacity brush. Create a new blank 
layer, select the Sharpen tool, tick Sample All 
Layers and set a Strength of 50% or lower.

05 DODGE AND BURN
One of the best ways to enhance a 

photo is by lightening or darkening selected 
areas of the image. This can be done with 
the Dodge and Burn tools, but rather than 
use them directly on the image, a separate 
grey layer gives you greater control. To 
create a Dodge and Burn layer, hold down 
Alt and click the Create a new layer icon in 
the Layers panel. Give the layer a name, 
then choose Mode: Overlay. Check Fill with 
Overlay-neutral color and click OK. Now use 
the Dodge and Burn tools (with Range set to 
Midtones) to work on the new layer.

04 HEALING LAYER
Most photos contain unwanted 

marks or blemishes. The Spot Healing Brush 
tool is effective at removing these. The best 
way to apply the healing is on a new blank 
layer, so that you can easily tone down or 
remove selected healing work later without 
having to start from scratch because you 
healed directly on the background layer. 
To do this, create a new blank layer, choose 
the Spot Healing Brush tool from the Tools 
panel and tick Sample All Layers on the 
Options bar, then continue as normal.



D
Reset the foreground and background colors 
to black and white

ALT+[SCROLL WHEEL]
Zoom in or out of the image

[ OR ]
Resize the brush tip

CMD/CTRL+SHIFT+ALT+E
Create a merged copy of all the layers in the 
layer stack

SHIFT+[ OR ]
Cycle backwards or forwards through the 
layer blend modes

SPACE BAR
Temporarily switch the current tool to the Hand 
tool, for moving around the image while zoomed in

CMD/CTRL+[LAYER MASK]
Load the currently active layer mask as 
a new selection

ALT+[EYE ICON]
Switch off the visibility of all other layers in the 
layer stack, for before-and-after comparisons

CMD/CTRL+T
Activate the Free Transform tool

CMD/CTRL+I
Invert the color of a layer mask to black

SHIFT+[LAYER MASK]
Disable the effects of a layer mask

CMD/CTRL+J
Duplicate the current layer

X
Switch the foreground and background 
color swatches

14 keyboard shortcuts that will massively improve your 
speed and efficiency while working in Photoshop

CMD/CTRL+Z
Undo the last change made to the document. 
Works multiple times
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